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Introduction 

**This Tutorial is compatible with Workbench v1.0** 
 
Connectome Workbench (herein called ‘Workbench’) is a freely available software platform for 
visualization and analysis of neuroimaging data.  It is customized for handling data from the Human 
Connectome Project (HCP), including functional and structural connectivity and task-fMRI, using 
combined surface and volume visualization.  
 
The Workbench platform includes wb_view , the visualization graphical user interface used in this 
tutorial, and wb_command, a set of command line tools for performing simple to complex operations 
using volume, surface, and grayordinate data. wb_command is a required program for running the HCP 
pipelines (released Sept 2014).   
 
To get Workbench, users can download 64-bit Mac, Windows, and Linux versions from the HCP website 
(see Downloading Connectome Workbench v1.0 below). Getting the HCP-generated data necessary to 
complete this tutorial requires a few more easy steps. To get the data, users must sign up for an account 
on ConnectomeDB and agree to the HCP Open Access data use terms before downloading (see 
Downloading Tutorial Data below).  
 
This tutorial is written for users at all levels, from those new to brain mapping to regular users of FSL, 
FreeSurfer, Caret, and other brain-mapping platforms.  Workbench has its roots in Caret software 
developed by the Van Essen laboratory, but it has been thoroughly re-designed and re-implemented.  
Novel features of Workbench include: 
 

• Interactive viewing of functional connectivity 

• Improved user interface for selecting data layers and maps 

• Viewing fMRI time courses and other data series frame-by-frame, as movies, or as charts 

• Options to display multiple surfaces and volumes as tabs, windows, or as a “montage” within a 
single window 

• Parcellated connectivity matrix viewing with interactive parcel selection for viewing parcellated 
connectivity on surface and volumes   

• Compatibility with NIFTI, GIFTI, and CIFTI (surface + volume) data formats (Note: the CIFTI-2 
format was released in March 2014, see this link for details) 

• Help information integrated into the wb_view interface   

• Interactive viewing of structural connectivity and probabilistic fiber trajectories (coming soon!) 
 
New to Workbench 1.0 is an improved border file format that requires borders to be on a single brain 
structure.  Old border files can be read by wb_view and wb_command as long as the structures on 
which they were drawn are also loaded. In wb_view, old border files on a single brain structure will be 
automatically converted to the new format and just need to be saved using Save/Manage Files (see 

http://www.humanconnectome.org/
https://github.com/Washington-University/Pipelines
https://github.com/Washington-University/Pipelines
https://db.humanconnectome.org/app/template/Login.vm
http://www.nitrc.org/projects/nifti/
http://www.nitrc.org/projects/gifti
http://www.nitrc.org/projects/cifti/
https://www.nitrc.org/projects/cifti/
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Scene 9 for more details) to complete the conversion to the new format. For old border files on multiple 
brain structures, the user must use the Split Multi-Structure Border Files option in the Data Menu to 
separate the borders by structure before editing or saving borders in the new format. Scenes created 
with old border files will also open, but if modifications to the border files are made, the scene will need 
to be replaced to reflect the changes.  
 
You are encouraged to use this tutorial however it suits your experience level and learning style:  You 
can run through the full tutorial as written or skip around to sections covering features of particular 
interest. We have streamlined this WB v1.0 tutorial to be a quick “get your feet wet” guide, touching on 
most features of the software while exploring HCP data released to date.  
 
‘Scenes’ files, which provide a ready setup of data to show particular features, facilitate skipping 
between sections of interest (each scene has a separate section in the tutorial).  
 
Those who have not previously used Caret software may find the topics in the wb_view Help menu an 
easy way to become familiar with Workbench functionality, including using Workbench tools such as 
drawing borders/foci and creating Regions of Interest (ROIs). Another option for getting a quick look at 
500 Subjects HCP data released in June 2014, while learning Workbench basics, is to follow the 
ConnectomeWorkbenchTutorial_HCP_Q1-Q6_GroupAvg_Related440_Unrelated100_v1.pdf included 
in the Group Average Workbench Dataset available on the WU-Minn HCP Data – 500 Subjects page in 
ConnectomeDB.  
 
Information for running each command tool in wb_command is available at 
http://humanconnectome.org/software/workbench-command.php. 
Basic information on setup and syntax for using wb_command and wb_import, a tool distributed with 
Workbench for converting Caret 5 files to Workbench format, is included as the last chapter of the 
Workbench Beta v0.83 Tutorial and User Guide available at 
http://humanconnectome.org/documentation/tutorials/. The Beta v0.83 Tutorial also includes much of 
the help information on wb_view features and functions that now appear within the software in Help 
MenuWorkbench Help… in a printable document format that may be helpful to some users. 
  
Connectome Workbench is under active development, with many new capabilities to be added in the 
coming years. We encourage user feedback to help identify and prioritize refinements and needed 
features (Feature requests can be directly submitted through the Help Menu). The HCP-users public 
discussion email list is an open forum for discussing such issues.  You can join via 
http://www.humanconnectome.org/contact/#subscribe.  Once you have subscribed, you can set 
preferences to receive hcp-users postings to the list as individual messages or as a digest. Please send 
bug reports and suggestions to the list by emailing hcp-users@humanconnectome.org. 

Downloading Connectome Workbench v1.0 
** Skip this section if you have already downloaded and installed Workbench v1.0 (released September 
2014). You are ready to get started! 

http://www.humanconnectome.org/
https://db.humanconnectome.org/data/projects/HCP_500
https://db.humanconnectome.org/app/template/Login.vm
http://humanconnectome.org/software/workbench-command.php
http://humanconnectome.org/documentation/tutorials/
http://www.humanconnectome.org/contact/#subscribe
mailto:hcp-users@humanconnectome.org
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64-bit Mac, Windows, and Linux versions of Connectome Workbench v1.0 are available for download as 
zipped file archives from the Workbench download page on the HCP website (32-bit versions of 
Workbench are no longer being distributed because of multiple problems handling large data files). 

Operating system requirements for Workbench: 

* Mac 64-bit: Snow Leopard (OS X 10.6.X or later) 

* Linux 64-bit: Ubuntu 8.04 LTS or later, CentOS 6.2 or later and RHEL (Red Hat Enterprise Linux) version 
6 or later (may run on earlier systems, but this is not supported)  

* Windows 64-bit: Windows XP SP3 or later  

Download Instructions:  

• Download Workbench for 64-bit MacOSX, 64-bit Linux, or 64-bit Windows operating systems (in 
a zipped folder containing all necessary libraries) from the Workbench download page. 

• Unzip the folder. A subdirectory named ‘workbench’ will be created.  

• Move the ‘workbench’ folder to your Applications, Program Files folder, or other designated 
directory. Within the ‘workbench’ folder, is a ‘bin’ folder (named bin_[operating system]) that 
contains the executables for wb_view, wb_command and wb_import.  If desired, make a short-
cut icon to the program executable for your dock or desktop. For the mac64 version, the 'app' 
for wb_view is in workbench/macosx64_apps/wb_view.app 

To run Workbench from a terminal window, you need to set your PATH environment variable to the 
appropriate executable directory: 

For Mac users: If you moved the unzipped Workbench folder to Applications, set your PATH to:  
/Applications/workbench/bin_macosx64 

For Linux users: Set your path to [directory you placed the unzipped Workbench 
folder]/bin_linux64 (or /bin_rh_linux64 for RHEL).  

To set the PATH in Bash shell, enter this command in a terminal window: 
> echo 'export PATH=$PATH:/my/workbench/path/bin_linux64' >> ~/.bashrc 

To set the PATH in tcsh/csh shell, enter this command in a terminal window: 
> echo 'set PATH = ($PATH /my/workbench/path/bin_linux64)' >> ~/.cshrc 

where “/my/workbench/path” is the directory that contains the Workbench folder. 

Log out and log back in to make the change take effect. 
 

Connectome Workbench is Open Source and the source code is available at: 
https://github.com/Washington-University/workbench 

  

http://www.humanconnectome.org/
http://humanconnectome.org/connectome/get-connectome-workbench.html
http://humanconnectome.org/connectome/get-connectome-workbench.html
https://github.com/Washington-University/workbench
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Downloading Tutorial Data  
Downloading the HCP-generated neuroimaging data necessary to complete this tutorial is easy, but 
requires a few more steps. Briefly, to get the data, users must have an account on ConnectomeDB, have 
agreed to the HCP Open Access data use terms, and have installed the Aspera Connect plugin in their 
browser.  
 
Because of the large size of the data, downloading is facilitated through an Aspera server that requires 
you to have the Aspera plugin installed in your browser (available free to end users). Before you start 
the download process, if you have not installed the plugin yet, a warning message will appear at the top 
of your browser when reminding you that you must Install the Aspera plugin before downloading. 
 
Pre-download instructions: 

• Follow this link to install the Aspera Connect plugin for your browser. 
 
Download instructions: 

• Click the Tutorial Data button on the Workbench download page. 

• Instructions outlining the steps for this download process will popup. 

• Click on the “Go to ConnectomeDB” button. You will be taken to the ConnectomeDB login page.  

o If you have a ConnectomeDB account, enter your username/password and press Log In. 

o If you do not have an account, click the Register button to create one. 

 Click the link in the verification email that is sent to the email address you 
provided in registration. 

 Log in with your username/password. 

• The ConnectomeDB multi-projects splash page will open. 

o If you have previously signed the WU-Minn HCP Data Use Terms, skip the next step. 

o If you have not yet signed the WU-Minn HCP Data Use Terms, 
the WU-Minn HCP Data – 500 Subjects section will show a 
button under the description containing the words “Data Use 
Terms Required”. Click the button. 

 The Open Access Data Use Terms will popup. 

 Read the Data Use Terms and click the checkbox on the bottom left to agree to 
all terms.  

 Click the Accept Terms and Access Dataset button. 

o Click on “WU-Minn HCP Data—500 Subjects” or the “Resources” button in that section. 

o On the page that opens, scroll down to the Connectome Workbench Data section and 
click the Download Tutorial Dataset button.  

http://www.humanconnectome.org/
https://db.humanconnectome.org/app/template/Login.vm
http://downloads.asperasoft.com/download_connect/
http://downloads.asperasoft.com/download_connect/
http://humanconnectome.org/connectome/get-connectome-workbench.html
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 If you have the Aspera Connect plugin installed, the download will launch on 
your browser. 

 If you do not have Aspera Connect installed, you will see a warning message at 
the top of your browser with the link to the Aspera site.  

• Unzip the HCP_WB_Tutorial_1.0 zipped archive you just downloaded. 

The HCP_WB_Tutorial_1.0 folder contains a copy of these tutorial instructions and all the data files 
necessary to complete this tutorial, packaged in the same directory. You are ready to start the tutorial! 

WB 1.0 Tutorial Dataset 
As detailed above, the HCP_WB_Tutorial_1.0 zipped archive is available for download from the WU-
Minn HCP Data -- 500 Subjects project page in ConnectomeDB. The archive contains data Release notes, 
a copy of these tutorial instructions, and all the files necessary to complete this tutorial. The data 
contained in the archive includes individual subject (100307) and 440 subject (R440) group-average 
structural files (including surfaces at 32k and 164k mesh resolutions); maps of myelin, curvature, 
Freesurfer sulc and cortical thickness for 100307 and R440 (at 32k and 164k mesh resolutions); group-
average tfMRI grayordinates analysis results for R440, and label, borders, and foci files generated from 
other studies to use for reference. Because of their large size (33 GB each) the two group-average dense 
functional connectome files for R468 are remotely accessed in ConnectomeDB (shown below in Scenes 5 
and 6) through the following links: 

https://db.humanconnectome.org/spring/cifti-average?resource=HCP_Resources:GroupAvg:HCP_Q1-
Q6_R468_rfMRI_groupPCA_d4500 

https://db.humanconnectome.org/spring/cifti-average?resource=HCP_Resources:GroupAvg:HCP_Q1-
Q6_R468_rfMRI_groupPCA_d4500_MGTR 

to generate connectivity maps ‘on the fly’, requiring the user to have internet access and login using 
their ConnectomeDB account credentials. For those that would like a local copy, these dense 
connectome files and the Group-PCA Eigenmaps that can be used to create them locally using 
wb_command, are also available for download from the WU-Minn HCP Data -- 500 Subjects project 
page. 

Tutorial Conventions 
Some conventions in this document: 

• All tutorial steps are identified by bullets. 

• Actions the user should take are in italics.  

• Click refers to a left click with the mouse unless otherwise indicated. 

• User-interface components and file names are in bold. 

http://www.humanconnectome.org/
http://downloads.asperasoft.com/download_connect/
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• Some instructions are streamlined using arrows (e.g. Toolbar►L means press the L button in the 
Toolbar or File Menu►Open File means select the item Open File from the File Menu). 

• Several technical terms are defined in the Glossary in the Help Menu within wb_view.   

• All figures were made using the Mac OSX version of Workbench. The PC and Linux user 
interfaces appear slightly differently, but the functionality is the same. 

Launching Connectome Workbench (wb_view) 
• Windows: double-click the wb_view icon on the desktop or in your Program files folder. 

• Mac OSX: click the wb_view icon in the dock or in your Applications folder. 

• Linux (or Mac terminal): change (cd) to the HCP_WB_Tutorial_1.0 directory in a terminal 
window, then enter wb_view and press Return. 

http://www.humanconnectome.org/
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Figure 1 – Connectome Workbench Splash Screen 
 

 
Figure 2 – Workbench Help Window 
 

Exploring HCP Data in wb_view  

Workbench Orientation 
This section provides a quick orientation to the Workbench GUI, wb_view, while exploring individual and 
group average data from the HCP. One great feature of Workbench is the ability to utilize data files that 
include maps of both the left and right cerebral hemispheres in a single file using the CIFTI file format 
(based on the NIFTI-2 format, hence the *.nii ending, with a unique header structure).  For example, 
myelin maps for both hemispheres are contained in a single *.dscalar.nii file type; cortical parcellations 
for both hemispheres are contained in a single *.dlabel.nii file.  The scenes illustrated herein make use 
of these cifti files, but the dataset also includes conventional hemisphere-specific GIFTI files (e.g. 
*.surf.gii). 

Workbench Splash Screen 
When you launch Workbench, a splash screen opens (Figure 1), showing a list of Specification files 
(“Spec Files”) in the directory path you are currently opening Workbench from, plus Recently opened 
Spec Files, if you have launched Workbench before.  

A spec file organizes a set of data files for 
loading into the program at one time.  

• For now, click the Skip button to 
launch Workbench without 
opening a file. 

Menu Bar and Workbench Help 

The Menu bar, located at the top of your screen 
(Mac) or top of the blank Workbench window that 
just opened (Linux/PC), contains several menus for 
program-wide functions like file loading, setting 
preferences, and view options.  

The Help Menu► Workbench Help… (Figure 2), 
accessible through the Help         button in the upper 
right corner of the Workbench Window, contains 
information about using wb_view and wb_command 
utilities, including a Glossary of terms that may be 
new to users and information on the options in the 
Menus, wb_view features, and wb_command tools. 
Most of the Workbench features/elements in bold 
font in the tutorial have Help entries. It may be useful to keep the Help window open as you explore the 
program. 

http://www.humanconnectome.org/
http://www.nitrc.org/projects/cifti/
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Figure 3 - The Open File Dialog  
 

 
Figure 5 – The Scenes box   

 
Figure 4 - The Open Spec File Dialog  

Opening a Spec File and Loading Scenes 

• In the Menu bar, select File►Open File… (shortcut cmd/ctrl 
+ O) to display the Open File Dialog.  

• In the Open File Dialog (Figure 3), Navigate to the folder or 
directory that contains the data, the HCP_WB_Tutorial_1.0 
folder.  

o The default file type filter is Specification Files 
(*.spec). 

• Select the desired file: 
WB_1.0_Tutorial_DATA.32k_fs_LR.wb.spec 
and click the Open button.  

The Open Spec File Dialog (Figure 4) will 
appear, showing the files in this particular 
spec file, grouped into 8 types: Border, 
Dense Label, Dense Scalar, Dense Data 
Series, Foci, Scene, Surface and Volume.  

• Click Load Scenes at the bottom left of the 
dialog to open the scene file necessary for 
the tutorial.  

Often views in Workbench require several steps 
to set up, so we have provided scene files that 
offer a quick way to load views that show off the 
HCP data provided and many features of 
Workbench.  

• The Scenes box (Figure 5) will appear. In the 
Scenes field the first scene:  

“1. Individual surfaces and volumes” should be 
highlighted, indicating that it is selected.  

• Click Show to load the scene (Note: this might take 
several minutes if you are loading from a remote 
location). 

  

http://www.humanconnectome.org/
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   A                     B 

         
     Figure 6 - The Workbench Viewing Window  A) Vertical Orientation  B) Horizontal Orientation  

Scene 1: Individual surfaces and volumes 
This scene is set up to show brain surfaces and volumes of an individual subject (100307) scanned in Q1 
of the HCP to show the kind and quality of data generated at the single-subject level. It also provides a 
convenient backdrop to introduce the layout and some of the general features of Workbench.  

Workbench Window Layout 
The scene opens with the left hemisphere anatomical midthickness cortical surface (halfway between 
the pial and white matter surfaces) of the HCP subject 100307 in the Viewing Area of the Workbench 
Window (“Connectome Workbench 1”). Components of the Workbench Window are shown in Figure 6.  

The Workbench Window contains five Viewing tabs: (1) Montage, (2) Volume, (3) All, (5) Cortex Left, and 
(6) Cortex Right. 

The Viewing Area opens viewing tab 1 (the Active Tab) showing a montage of lateral and medial views 
of both left and right cerebral cortex midthickness surfaces. We will browse all the tabs now and go 
through them in further detail below. 

• Click on Tab (2). This shows parasagittal, coronal and axial T1-weighted volume slices of this 
individual. The colored outlines demarcate the pial and white matter boundaries in this 
individual. 

• Click on Tab (3) All. This view shows the midthickness surfaces of both hemispheres and all 3 
volume planes (parasagittal, coronal, axial).  

• Click on Tab (5) CortexLeft. This shows the left cerebral midthickness surface.  

• Click on Tab (6) CortexRight. This shows the individual’s myelin map overlaid on the inflated 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingArea
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right cortical surface.  

• Click through the tabs again and notice that the Toolbar changes when you switch tabs/views. 

The Overlay Toolbox (where one sets data layers for viewing on structures) can be displayed in two 
locations/orientations: on the left or on the bottom of the Viewing Area, Figure 6A and B. On startup, 
the choice is automatically made based on the resolution of your monitor (if the vertical resolution is 
800 or less, the overlay toolbox will be on the left).  

For the purposes of this tutorial, all instructions and figures assume you are using the horizontal 
orientation layout (Figure 6B), with the Overlay Toolbox attached to the bottom of the Viewing Area.  

• Click back to Tab (5) CortexLeft.  

• Press the left mouse button and drag your mouse anywhere in the Viewing Area to rotate the 
surfaces.  

• To zoom, scroll your mouse wheel up and down anywhere in the Viewing Area. If you don’t have 
a mouse wheel, press the command (Mac)/control (Linux/PC) key while pressing the left mouse 
button and moving your mouse up and down. 

Toolbar 
The Toolbar at the top of the Viewing Window contains display settings for the brain structures you 
are viewing.  

• Clicking the Orientation buttons (right), you can display the surface in 6 standard 
views: L (Lateral), M (Medial), D (Dorsal), V (Ventral), A (Anterior), P (Posterior). Click 
the Reset button to reset to the lateral view at the original zoom setting. 

The Brain Structure and Surface (Selection) section of the Toolbar lets you switch brain structures and 
also surface configurations.  

If you accidentally left clicked on the brain surface, you have discovered the Information Window. Just 
click on Close at the bottom of the box to remove (the Information box is described in more detail 
below). 

If you left click and drag the top of the Overlay Toolbox, it can be pulled off of its docking point in the 
Workbench Window to float any place on your desktop.  As you do this, the images in the Viewing 
Area will resize to fill the Workbench Window. This is one convenient way to quickly get a larger view 
of the structures being displayed.  

Double click on the top of the Overlay Toolbox to make it return to its docked position. The same 
functionality is also available for the Features Toolbox (described in the sections on Scenes 9 and 10).  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-FeaturesToolbox
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• Click on the lower dropdown  
(currently showing 100307.L.midthickness.32k_fs_LR.surf.gii). 

• The different left surface configurations available for subject 100307 are shown (flat, inflated, 
midthickness, pial, sphere, very inflated, white) along with the group average surfaces available 
for the HCP Q1-Q6 Related 440 (R440) subjects (more on the R440 data in Scene 2: Individual vs. 
Group Avg surfaces).  

• Now, right click on the same lower dropdown and press your up and down arrow keys to browse 
through all the selections from both the individual and group surfaces.  

Surface Layers 
• Click on tab (6) CortexRight at the top of the Workbench Window to switch the view to the 

right hemisphere. This tab is set to display the inflated right hemisphere surface of subject 
100307 with the top layer displaying a map of myelin content.  

• Rotate the surface (press the left mouse button and drag your mouse). Red and orange 
represent heavily myelinated regions, purple and black represent areas of low myelin content 
(Glasser & Van Essen, 2011).  

• Move the cursor down to the Overlay Toolbox below the Viewing Area. There are 4 tabs in the 
Overlay Toolbox. You are currently viewing the Layers tab. 

Layers are arranged like a layer cake—the topmost layer to be displayed on the surface is listed first, 
the one below it second, etc. The ‘On’ toggle, on the left, controls whether a layer is currently 
displayed, here, layer 1 is toggled off.  

In this case, a FreeSurfer generated parcellation dlabel file is listed on top (but is toggled off), the 
second layer is the Myelin Map file that you are viewing, and the third layer is a file representing 
cortical shape based on sulcal depth. These CIFTI scalars files contain scalar surface data for both left 
and right hemispheres (if data is available, CIFTI files can also contain surface data for cerebellar 
vertices and volume data for subcortical gray matter voxels).  

• Click the checkbox to the left of the top layer to turn it on and show the 
parcellations_VGD11b.L.32k_fs_LR.dlabel.nii file. This is a composite cortical parcellation based 
on architectonic or retinotopic fMRI maps (Van Essen et al. 2011b) that covers only part of the 
cortical surface (that is why the myelin map “shows through” in areas). 

• Now toggle the top layer off again to expose the myelin map fully.  

• Click the P button for a posterior view in the Orientation section of the Toolbar, then click the L 
button for a lateral view.  

Whenever you encounter any dropdown menu in Workbench, you can right click the menu and 
quickly browse through selections using your up and down arrow keys, or search through selections 
by name by typing the first letter of what you are looking for.    

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/32/11597.long
http://cercor.oxfordjournals.org/content/early/2011/11/02/cercor.bhr291.long
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Figure 7 – Vertex Identification and the Information Window 

o There is heavy myelination in much of the occipital lobe, including the orange-yellow 
patch around where area MT should be, near the occipito-temporal junction—lower left 
in lateral view.  

• Click on the surface within this patch over area MT (see Figure 7).  

• The Information Window will pop up.  

• In the Viewing Area, a white sphere has appeared at the brainordinate (i.e. surface vertex or 
volume voxel) you selected.  Your viewing window should look like Figure 7.     

• In the Information 
Window, information on 
the brainordinate that 
you clicked is listed. For 
example, the XYZ 
coordinates and the 
labels assigned to the 
identified vertex are 
shown.  

Information (e.g. metric 
values, label names) on 
the vertex you selected is 
pulled from all currently 
loaded files that contain 
data for the structure 
being viewed (right 
hemisphere), whether or 
not they are currently 
being displayed.  

• Toggle the top parcellation layer back on, and note that the vertex you identified in the myelin 
map is in the red patch defined by area MT in the VGD11b parcellation map.  

• Click on several more places on the surface. Each time you click, information on the newly 
identified vertex appears at the bottom of the listed information in the Information Window.  

• Notice that the last vertex you clicked appears larger than the ones you clicked earlier. 

• Click the Properties button on the right side of the Information Window to open the Symbol 
Properties box to change the color or size of the earlier and most recently identified ID spheres.  

• Change the ID symbol color to Blue. Click Close.  

You can move the placement of the Information Window by dragging the top of the box to the 
desired position on your desktop. This position is saved when you close the box and remains where 
you set it, even between WB sessions.  

http://www.humanconnectome.org/
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• Click the Clear button at the top left of the Information Window to clear all the information in 
the box, without removing the identified vertices from the surface. 

• Click a few more places on the surface. 

• Click the RID button (short for ‘Remove ID’) to remove all the identified nodes on the surface, 
without removing the ID information in the Information Window.   

• Click the Close button at the bottom right of the Information Window. The Information box will 
stay closed until you identify another brainordinate. If you don’t want the Information Box 
popping up every time you click a brainordinate, you can move it to the background (behind the 
Workbench Window) by clicking the Information Window button         in the upper right of the 
Workbench Window. 

Montage View 
• Click on the first tab (1) Montage at the top of the Workbench Window to switch the view to 

display lateral and medial sides of both the left and the right hemisphere cortical surfaces. Here, 
we are looking at a Freesurfer sulc map on the midthickness surface of subject 100307. You can 
readily appreciate the differences in cortical folding between the hemispheres in this view. 

• Click a few places on the left hemisphere lateral surface (upper left) to see highlighted 
brainordinates in blue (if you changed the ID symbol color to blue in the Surface Layers section 
above). The Information box should popup, if not, click the Information box button to bring it 
back to the foreground.   

• In the right side of the Information box click the Contra ID button (short for ‘Contralateral 
identification’). 

• Click again anywhere on the left hemisphere lateral surface. Now, a blue sphere will appear 
where you clicked and a green sphere will appear in the geographically corresponding location 
on the right hemisphere lateral surface (upper right).  

• Click on the right hemisphere medial surface (bottom right) and note a green sphere appears on 
the corresponding location on the left hemisphere medial surface.  

• Notice the checkboxes labeled “Left”, “Lateral”, “Medial” and “Right” at the top of the Montage 
Selection section of the Toolbar to toggle the surfaces on and off. When you do this, the 
surfaces resize to fill the available viewing space. You may need to resize your Workbench 
Window or zoom out if you don’t want the montage surfaces to overlap.  

You can hide or show the Help Window, Information Window, Scenes Window, Toolbar, Overlay 
Toolbox, or Features Toolbox by clicking the buttons for each of these Window Elements, located in 
the upper right corner of the Workbench Window. As you do this for the Toolbar, Overlay Toolbox, or 
Features Toolbox, the images in the Viewing Area will resize to fill the Workbench Window.  

http://www.humanconnectome.org/


 

Connectome Workbench v1.0 Tutorial and User Guide | WU-Minn Consortium of the HCP Page 16 

• The checkboxes at the left side of Montage Selection allow you to toggle up to two selected 
surfaces on and off. Click the bottom checkbox to toggle on the group average midthickness 
surfaces.   

• Turn the surfaces and see that they all move together in a yoked fashion. 

• Click RID in the Information Window. Click the Close button. 

Volume View 
• Click on the second tab (2) Volume at the top of the Workbench Window to switch the view to 

display parasagittal, coronal, and axial (horizontal) volume views of subject 100307. In each 
slice, the pial surface is outlined in blue and the white matter/gray matter boundary is outlined 
in lime.  

o These are T1 weighted (T1w) volume slices at the slice indices indicated in the Slice 
Indices/Coords section of the Toolbar. 

o Notice also in the Slice Indices/Coords section, that the Move Volume Slice to Identified 
Location button          is gray, meaning that it is active.  When this button is active, and a 
brainordinate is identified in this or any Viewing Tab that this tab is yoked to, the 
volume image slice plane shown will move to the plane of the identified brainordinate.   
Since you identified brainordinates in a yoked Viewing Tab in the previous (Montage 
View) section, the slice planes displayed will be at the last location you identified (likely 
close to the edge of the volume).   

o Click the vertical ORIGIN button at the right side of the Slice Indices/Coords section of 
the Toolbar to reset the slice planes. 

o Click on the “P” slice index field in Toolbar: Slice Indices/Coords. 

o Scroll up and down (or use the arrow keys) to move through the parasagittal slices. 
Notice that the vertical cross hair on the coronal and axial slices move as you scroll. Try 
this function on the coronal and axial slices. 

• Toggle the T1w (first layer) off and the T2w (second layer) volume on in the Overlay Toolbox 
Layers tab. Now you are viewing the T2 weighted volume slices. 

• Click on the Vol/Surf Outline tab at the top of the Overlay Toolbox.  

• Toggle off the pial and white matter surface outlines. If you don’t see these listed, scroll down 
on the right side of the tab.  

• In the Viewing Area, zoom in on the slices to more clearly see the T2w data for this subject. 

• Click back to the Layers tab of the Overlay Toolbox. 

• Toggle the T1w top layer volume back on.  Toggle off/on to compare with the T2w layer below.  

o In the T1 and T2 weighted volume data you see here, you can appreciate the 
exceptionally high quality and resolution we are achieving in HCP.  

http://www.humanconnectome.org/
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Figure 8 – All (Whole Brain) view 

All (Whole Brain) View  
• At the top right of the Workbench Window, click on tab (3) All.  

• In the Orientation section of the toolbar, click the vertical RESET button.  

• Click the vertical ORIGIN button at the right side of the Slice Indices/Coords section. 

• Drag the surface up and to the right to rotate the surface and volume (whole brain) and see that 
surfaces of both hemispheres and all 3 volume planes (parasagittal, coronal, axial) are visible 
(Figure 8).  

• Toggle the VOLUME… file (bottom 2 layers) off 
in Overlay Toolbox:Layers. 

• In the Toolbar: Surface Viewing section, change 
the surface from Anatomical to Inflated.  

• With your mouse cursor in the Viewing Area, 
zoom in.  

• To pan, or move the surface vertically or 
horizontally within the Viewing Area, hold down 
the shift key while pressing the left mouse 
button and moving your mouse side to side or 
up and down. 

 

  

http://www.humanconnectome.org/
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Figure 9 – Tile Tabs view comparing individual and 
group average surfaces and volumes 

Scene 2: Individual vs. Group Avg surfaces and volumes 
• Reopen the Scenes Window by clicking the clapboard          button in the upper right of the 

Workbench Window. 

• Select “Individual vs Group Avg surfaces and volumes” and click Show to load the scene.  

This scene compares the Individual surfaces and brain volume of HCP subject 100307 with the group 
averaged surfaces and volume of 440 subjects (some of whom are related, a.k.a. the R440 group) in the 
HCP 500 Subjects dataset (June 2014).  

The scene opens with all tabs being displayed as tiled tabs: (1) 100307 Montage at the top left, showing 
both hemispheres of the individual anatomical midthickness cortical surface of subject 100307; (2) R440 
Montage at the top right, showing the R440 group-average midthickness surface; (3) 100307 Volume, 
showing a parasagittal slice plane view of the 100307 individual T1 weighted volume; (4) R440 Volume, 
showing the R440 group-average T1w volume at the same parasagittal slice plane (117) as the 
individual. 

As you can see, Tile Tabs view allows comparison between tabs within the same window. Enter and exit 
Tile Tabs view through the View menu and select Enter/Exit Tile Tabs, or shortcut Cmd/Ctrl + M.  Tile 
Tabs Configuration (in the same menu) allows one to create custom configurations for viewing tabs that 
capitalize on the available display space.  

The Toolbar and Overlay Toolbox show the controls for the Active tab (Tab 3). You can switch the 
controls to a different tab simply by clicking on the tab you want at the top of the Workbench Window—
the “tile” in the Viewing Area that corresponds to that tab will be indicated by the brief appearance of a 
white box around it.  

• Click on the          and         buttons to hide the Toolbar and Overlay Toolbox, respectively, 
allowing for a larger display (Figure 9). 

You can see the marked difference between the 
midthickness surface of the individual 100307 and 
the averaged midthickness derived from 440 
subjects, each of which was registered to 
FreeSurfer’s fsaverage atlas surface. The group-
average has convolutions similar to those of the 
individual in regions of consistent folding and a 
very different pattern in regions of high inter-
subject variability. Group-average surfaces are 
important to the HCP and other brain mapping 
projects as a substrate that reflects common 
characteristics and avoids the bias of any 
individual subject.  

The group-average volume was generated using 
FSL’s nonlinear FNIRT volume-based registration, 

http://www.humanconnectome.org/
http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FNIRT
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which aligns subcortical structures very accurately.  For cortical gray matter, FNIRT registration does not 
invariably respect the topology of the cortical sheet (in contrast to the FreeSurfer surface-based 
registration discussed above). 

Tiled tab view allows you to interact with the structures in each of the displayed tabs independently. 

• Move your mouse into the upper right quadrant, hold your left mouse button down and drag to 
rotate the group average surfaces.  

You can zoom, pan, and rotate any of the 3D structures separately (these functions, except 
rotation, also work for 2D structures, e.g. volume slices and flat surfaces).  

http://www.humanconnectome.org/
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Figure 10 – Comparison of individual and R440 
group average myelin maps.  

Scene 3: Individual vs Group Avg Myelin Maps on R440 
Surfaces 

• In the Scenes Window, select “3. Individual vs Group Avg Myelin Maps on R440 Surfaces” and 
click Show to load the scene (if necessary, reopen the Scenes Window by clicking the         
button). Leave the Scenes Window open.  

This scene opens showing a map of subject 100307’s myelin content on R440 group-average surfaces 
overlaid on a (hidden) map of group-average myelin content averaged across the R440 subjects (layer 2).  

• Click the first layer off. Now a map of group-
average myelin content averaged across the 
R440 subjects (layer 2) is showing.  

• Toggle off and on to compare with the 
individual myelin map (Figure 10). The R440 
myelin map appears smoother since many 
subjects were averaged in this group.  

• Rotate the surfaces (press the left mouse button 
and drag your mouse). Red and orange 
represent heavily myelinated regions, purple 
and black represent areas of low myelin content 
(Glasser & Van Essen, 2011).  

• Click the Settings         button next to the top 
layer.  The Overlay and Map Settings box 
appears with the Palette tab selected (only type 
of Settings available for this dscalar file). Here, 
you can set palettes, thresholds, and view a 
histogram of the data.  

• Click on the Help          button in the upper right 
of the Workbench Window. This opens the Help 
Window shown in Figure 2.  

• Scroll down on the left to:  

Overlay Toolbox  
Layers 

Overlay and Map Settings 

• Click on Overlay and Map Settings (resize the Help Window to see the full text). This opens Help 
information for the settings available in the different tabs of the Overlay and Map Settings box, 
including Palette settings. The image at the bottom of this Help entry shows the Palette tab with 
Thresholds On. 

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/32/11597.long
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• Try changing some of the Palette settings for this top layer. Move the Help and Overlay and 
Map Settings windows so that you can look at both and see the Viewing Area of the main 
Workbench Window. 

• Maps of parcellation labels and resting state networks (RSN) mapped from other studies and 
thickness/corrected thickness maps are part of the tutorial dataset for comparison to the myelin 
maps. Use the Overlay Toolbox Layers: File  dropdowns to display these loaded files on the 
surface and the Map pulldown to explore each file’s maps. 

 
We have provided borders and foci files in the dataset for comparison. These are loaded in this scene 
and can be shown using the controls in the Features Toolbox (open using the          button in the top 
right corner of the Workbench Window).  See scenes 9 and 10 for more details. 
 
Also, WB_1.0_SCENES.164k_fs_LR.scene (see Exploring HCP data at 164k Vertex Resolution below) 
shows this comparison and the others we have made in Scenes 1-3 at higher spatial resolution and the 
ability to browse individual maps for all R440 subjects. Note: Workbench can not load data at different 
mesh resolutions in the same session or scene. 
 

  

http://www.humanconnectome.org/
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Figure 11 – BOLD Time-Series on surface and volume slice 

Scene 4: Resting State fMRI Time Series surfaces and volumes 
• In the Scenes Window, select “Resting State fMRI Time Series surfaces and volumes” and 

click Show to load the scene. Leave the Scenes Window open. (If necessary, reopen the 
Scenes Window by clicking the clapboard           button).  

This scene opens showing the first frame of a resting state fMRI dense time series from an individual 
HCP pilot subject, CP10101.  

On the left side of the Viewing Area (in 
Tile Tabs view), the CP10101 resting 
state time series is displayed on the 
R440 group averaged inflated left and 
right hemisphere surfaces (in All view). 
On the right side, the R440 group 
averaged volume with the same 
CP10101 resting state time series 
mapped for the subcortical volume 
voxels in a cortical slice and for the 
surface outline (of the R440 group 
averaged midthickness surface).  

Note: Certain recent model Mac 
graphics cards show a blocky surface 
outline with small gaps—this is 
something we are working to fix. 

This is the first (time 0 seconds) BOLD 
activation frame of the resting state 
time series. The default ROY-BIG palette (Figure 11)—shows high BOLD signal in yellow/orange/red and 
low BOLD signals in cyan/green/violet/blue (after regressing out the global mean signal).  

• Click the up arrow in the frame number field, and watch the BOLD maps change for successive 
time frames.  

• With the cursor in the frame number box, you can hold down the up arrow button on the 
keyboard (or scroll with your mouse scroll wheel) for an animation effect and watch the map 
change over time. 

• Because the data in Tab 1 is yoked with the data in Tab 2, both the surface outline and the 
volume voxels will refresh with each new timepoint—pretty cool!  

• Click on Tab (2) Volume to make it the Active Tab. Move your cursor to the “C” slice index field 
(coronal) of the Slice Indices/Coords section of the Toolbar and scroll, toggle up and down (or 
use the arrow keys) to look at the data for one timepoint as you move through the slice planes. 

http://www.humanconnectome.org/
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Figure 12 – Dense Time-Series display with Charting 

Charting dense timeseries 

• Select FileNew Tab (shortcut Cmd/Ctrl + T). A new Viewing Tab will be created (3) CortexLeft. 

• Select ViewTile Tabs Configuration All Tabs (Default) to show the new tab in Tile Tabs. 

• Change the View in the Toolbar to Chart.  The Charting tab is automatically activated in the 
Overlay Toolbox.  

• Click the Select checkbox in the Overlay Toolbox:Charting:Loading tab to turn on charting of the 
loaded CP10101 dense time series (*dtseries) file when brainordinates are selected.  

• Click on any yellow location on the surface in the first tiled tab. The chart will display a graph of 
the activation timecourse for the selected brainordinate. The graph is shown in the same color 
as the ID sphere shown on the surface. 

• Resize the Workbench window to a greater width to better see the chart by left click + dragging 
the lower right corner of the window.  

• Click again anywhere on the surface or on the colored subcortical voxels. The chart will update 
showing the second selected brainordinate’s timecourse along with the first timecourse. 

• Click the History tab in the Overlay Toolbox. Selected brainordinates with the associated plot 
color are listed in reverse order (most recent selected brainordinate on top). The checkboxes 
allow you to toggle off/on particular plots in the chart. The show last box sets how many 
selected 
brainordinates are 
shown in the history.   

• Click the Show 
Average checkbox. 
The display is shown in 
Figure 12. This button 
computes the average 
of the plots currently 
displayed in the chart 
tab and shows the 
average in a different 
color on the chart. 
Toggle off the 
checkbox to turn off 
the average chart.  

 

  

http://www.humanconnectome.org/
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Figure 13 – Comparing group-average full correlation functional connectivity for three brain locations.  

 

Scene 5: fcMRI, Full Correlation, R468 surfaces and volume 
montage 
**Note: Scenes 5 and 6 use HCP R468 group averaged rfMRI data. To date (September 2014) HCP has 
not yet released the extensively processed resting state functional connectivity for individuals as we are 
still optimizing our pipelines for these analyses (but see http://www.humanconnectome.org/data/ for 
descriptions of all HCP image and behavioral data released on ConnectomeDB).  

This scene displays full correlation group-average functional connectivity data from 468 ‘related’ Q1-Q6 
subjects (R468) with complete resting state fMRI interactively on the cortical surface and in subcortical 
volumes. 

• Select “fcMRI, Full Correlation, R468 surfaces and volume montage” in the Scenes Window and 
click Show to load the scene. Leave the Scenes Window open.  

• A Username and Password Dialog will pop up. 

• Enter your ConnectomeDB username and password (same information you used in the 
Workbench data download process). Click OK. 

• Workbench is now accessing ConnectomeDB in order to retrieve functional connectivity data for 
a preselected surface vertex (this may take several seconds, if you get an error, make sure you 
are connected to the internet). 

The scene opens displaying an inflated surface montage view (left) and coronal volume montage (right) 
of R468 group-average full correlation functional connectivity between the vertex on the left 
hemisphere surface (shown in white) and all other grayordinates, including subcortical voxels.  

With this color palette, brain regions that are positively correlated (by Pearson’s r-value that has been 
Fisher transformed) to the identified grayordinate are yellow, orange, and red; those that are negatively 
correlated (very few places in the full correlation) are displayed in blue, green, and indigo.  

• Click on the left hemisphere surface in the ventral part of the precentral gyrus, approximately 
the same place as the highlighted vertex in Figure 13A (upper left).  

This shows a map of R468 functional connectivity associated with the face representation in motor 
cortex.  

http://www.humanconnectome.org/
http://www.humanconnectome.org/data/
https://db.humanconnectome.org/data/projects/HCP_500
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Figure 14 – Full correlation functional connectivity for a subcortical voxel seed. A) R468 group-average, 
subcortical volume view, B) R468 group-average, surface view.   

 

• Click on the location on the postcentral gyrus (shown in Figure 13B) to view the similar 
functional connectivity map for the face representation of somatosensory cortex.  

• Now click an area in the supramarginal gyrus (shown in Figure 13C). You will see a much 
different connectivity pattern than for either of the previous maps. This demonstrates how 
nearby brain regions can have very different resting state functional connectivity from each 
other. 

• Click on a subcortical voxel in the upper right panel of the volume montage (shown in Figure 
14A) to view the R468 group-average full correlation and the other subcortical grayordinates 
shown. 

• On the left side of the Workbench Window, we see the R468 full correlation connectivity 
between the subcortical voxel you identified in the volume slice and the surface grayordinates 
(Figure 14B). 

  

http://www.humanconnectome.org/
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Figure 15 – Comparing R468 group-average functional connectivity correlation with mean 
grayordinate timecourse regression for three brain locations.  

 
 

 

Scene 6: fcMRI, MGT-regressed correlation, R468 surfaces and 
volume montage 
Similar to Scene 5, this scene displays group-average resting state correlation functional connectivity in 
which the mean grayordinate time series (MGT) has been regressed out of the data.  

• Select “fcMRI, MGT-regressed correlation, R468 surfaces and volume montage” in the Scenes 
Window and click Show to load the scene. Leave the Scenes Window open.  

• A Username and Password Dialog will pop up. 

• Enter your ConnectomeDB username and password (same information you used in the 
Workbench data download process). Click OK. 

• Workbench will retrieve R468 MGT-regressed functional connectivity data for a preselected 
surface vertex (again this may take several seconds, and requires an internet connection). 

The scene opens displaying an inflated surface montage view (left) and coronal volume montage (right) 
of R468 group-average MGT-regressed correlation between the vertex on the left hemisphere surface 
(shown in white) and all other grayordinates.  

With this color palette, brain regions that are positively correlated (by Pearson’s r-value that has been 
Fisher transformed) to the identified grayordinate are yellow, orange, and red; those that are negatively 
correlated (after regression of the mean gray-matter timeseries) are displayed in blue, green, and 
indigo.  

• Click on the left hemisphere surface in the ventral part of the precentral gyrus, approximately 
the same place as the highlighted vertex in Figure 15A (upper left).  

This shows R468 MGT-regressed functional connectivity associated with the face representation in 
motor cortex.  

• Click on the locations on the postcentral gyrus (shown in Figure 15B) to view the similar 
functional connectivity map for the face representation of somatosensory cortex and on a green 
or blue area in the supramarginal gyrus (shown in Figure 15C) to see a much different 
connectivity pattern than for either of the previous maps.  

http://www.humanconnectome.org/
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Figure 16 – Alternative representations of functional connectivity maps using an exemplar seed in the 
right MT+ area (gray arrows).  A.  Functional connectivity map after regression of the mean gray 
timecourse (MGT).  B.  Full correlation functional connectivity map for the same seed location.  

 
 

 

• As in Scene 5, you can click on the subcortical voxels in the volume slices to interactively view 
the MGT-regressed correlation functional connectivity maps seeded from subcortical gray 
matter. 

Comparing functional connectivity maps: Correlation with regression of the 
mean gray timecourse vs. full correlation 

• Click on the Overlay Toolbox: Connectivity tab.  

The On checkboxes in the Connectivity tab allow one to control whether data is loaded for Connectivity 
files (or Fiber Orientation Files, if available) when brainordinates are identified.  

• Click the On box for the …: HCP_Q1-Q6_R468_rfMRI_groupPCA_d4500 (Full correlation) group 
average Connectivity File.  

• Click back to the Layers tab and click the On checkbox for the second layer (set to the HCP_Q1-
Q6_R468_rfMRI_groupPCA_d4500 Full correlation link). 

• Click on a location on the surfaces. Note that the Map Row listed for both layers 1 and 2 update 
to match the newly identified vertex. 

• Toggle off/on the first (MGT-correlation) layer to compare it with the Full correlation layer 
under it for the same brainordinate seed (Figure 16 shows one such comparison). 

• Repeat with other selected brainordinates.  

http://www.humanconnectome.org/
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• Click on the (2) Volume Viewing tab title to make it the Active Tab. Now the Overlay Toolbox 
shows the layers set for the Volume viewing tab. 

• Toggle off/on the first (MGT-correlation) layer to compare it with the Full correlation layer 
under it in the volume slices. 

• Click on a colored subcortical grayordinate voxel to seed the connectivity from that 
brainordinate.  

The interpretation of both types of functional connectivity map is complex.  Neither the full connectivity 
map nor the MGT-regressed map represents ‘ground truth’ anatomical connectivity (see Smith et al., 
2013, Glasser et al. 2013, Van Essen et al., 2013).  Having both available for the same datasets should 
facilitate evaluation of the relative strengths and limitations of each way of representing functional 
connectivity.   Alternative representations, such as partial correlation, can also be explored (see Smith et 
al., 2013).  It is likely that this will remain a topic of ongoing debate and discussion in the field.   

  

http://www.humanconnectome.org/
http://www.sciencedirect.com/science/article/pii/S1053811913005338
http://www.sciencedirect.com/science/article/pii/S1053811913005338
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005351
http://www.sciencedirect.com/science/article/pii/S1053811913005338
http://www.sciencedirect.com/science/article/pii/S1053811913005338
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Figure 17 – R440 group-average task contrast for the 2-back vs 0-back 
working memory task. 

 

Scene 7: tfMRI (2BK-0BK WM), R440, on surfaces and volume 
montage  

• Select “tfMRI (2BK-0BK WM), R440, on surfaces and volume montage” in the Scenes Window 
and click Show to load the scene. Leave the Scenes Window open.  

**Note: This scene shows HCP 500 Subjects group averaged data. Task fMRI data that has been 
analyzed across runs for individual HCP subjects at various smoothing levels on the surface and at 4mm 
smoothing across the volume has been released and is available from ConnectomeDB.   

This scene opens to show R440 group-average 2back-0back contrast of the HCP Working Memory task 
on the inflated R440 surfaces (left) and coronal volume montage (right) for subcortical graymatter.  

The fMRI data processing included grayordinate-constrained smoothing (2 mm FWHM, respecting 
cortical surface topology and subcortical parcel boundaries).  This has advantages over the volume-
based smoothing that is conventionally applied to fMRI data (see Glasser et al. 2013, Barch et al., 2013).  
Additionally, the averaging across subjects occurs in the grayordinate space, in which the cerebral cortex 
is better aligned across subjects because of surface-based registration using MSMSulc (see HCP 500 
Subjects Release Reference Manual  for more details).  

Figure 17 shows the 
unthresholded activation 
maps from the 2-back vs 0-
back task contrast.  
Activations related to 
working memory are most 
prominent in lateral 
prefrontal cortex but also 
include anterior cingulate 
cortex and lateral parietal 
cortex.    

The color bar in the lower 
left shows a maximum z-
statistic value of 17.3 and 
minimum of -11.8.  (In this 
and other figures, the color 
bars span the +/- 98% 
range of z-values; the 
actual ranges are higher.  
Options for setting z-statistic thresholds, adjusting the palette colors, etc. are available using the Layers: 
Settings:          button (see Help MenuWorkbench Help…Overlay ToolboxLayersOverlay and Map 
Settings).  

In this task, participants were presented with blocks of trials that consisted of pictures of places, tools, 
faces and body parts (non-mutilated parts of bodies with no “nudity”). The participants are asked to 

http://www.humanconnectome.org/
https://db.humanconnectome.org/data/projects/HCP_500
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005272
http://humanconnectome.org/documentation/S500
http://humanconnectome.org/documentation/S500
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perform a working memory task to remember the picture 2 pictures back (2 back condition) or 
remember the picture they just say (0 back condition). 

• Click on the Map pulldown for the first layer. A listing of all the tfMRI contrasts from all of the 
tasks in the HCP protocol appears.  

• Click on the names of other contrasts in this list to explore them as you wish.  

• You may also toggle the Frame number to the left up or down to browse through the available 
contrasts .  

A full description of the tasks in the HCP protocol is provided in the HCP 500 Subjects Reference Manual.  

Important note about the Related 440 (R440) dataset. Many of the 440 subjects in the R440 dataset are 
related. However, family structure was not taken into account in the tfMRI group average analyses of 
R440. Therefore, the associated standard errors and p-values are optimistic. Since the p-values are not 
valid, any false discovery rate (FDR) inferences based on them will not be valid either. We plan for 
standard errors and p-values to be revised in future related datasets once family structure is 
incorporated into the analysis. 

  

http://www.humanconnectome.org/
http://humanconnectome.org/documentation/S500
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Figure 18 – R440 group-average task contrast for the 2-back vs 0-
back working memory task. 

 

Scene 8: Parcellated MGTR Connectivity, R196, RSN parcels: 
Surface and Matrix chart display 

• Select “Parcellated MGTR Connectivity, R196, RSN parcels: Surface and Matrix chart display” in 
the Scenes Window and click Show to load the scene. Leave the Scenes Window open.  

This scene opens to show group-average mean gray-time course-regressed connectivity between 
contiguous resting state network (RSN) parcels for a group of 196 related HCP subjects (R196) on cortical 
surfaces (left) and in a parcellated connectivity matrix chart (right).  

The file HCP_R196_mgtr_MSMAllDeDrift_Yeo2011_17Networks_ContiguousParcels.32k_fs_LR.pconn.nii 
being displayed as both the surface map and matrix chart was generated in wb_command as follows:  

The ‘cifti-parcellate’ command was used on the R196 group average dense timeseries data to generate 
the average time series data within a set of resting-state network (RSN) parcels based on a study by Yeo 
et al. (2011), and further processed to subdivide each RSN into a set of topologically contiguous parcels.  
The ‘cifti-correlation’ command was used to determine the functional connectivity, based on the 
correlation between time-series data for each pair of parcels. 

For details on wb_command tools, see the Help MenuWorbench Help… or the wb_command 
documentation available at: http://humanconnectome.org/software/workbench-command.php  

The scene opens with a 
brainordinate already identified 
in the parietal cortex (Figure 18).  
Notice that the region around 
the selected brainordinate is 
colored yellow and outlined in 
white on the surface. The white 
outline indicates the selected 
parcel for which the connectivity 
with other parcels is shown. As 
with the previous functional 
connectivity scenes, the color 
spectrum is from yellow to cyan, 
with the highest correlation 
displayed in yellow. On the right, 
the selected parcel is indicated 
by a white outline around the 
matrix row showing the color-
coded correlation values of that 
parcel with the others.  

• Select a brainordinate in a different parcel (the motor strip parcels surrounding the central 
sulcus provide a nice contrast). 

http://www.humanconnectome.org/
http://jn.physiology.org/content/106/3/1125.long
http://jn.physiology.org/content/106/3/1125.long
http://humanconnectome.org/software/workbench-command.php
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• Notice that the white outlined row in the parcellated connectivity matrix has jumped to the row 
for the newly identified parcel. 

• Click RID in in the Information Box to remove all the ID spheres. 

• Click on a new row in the connectivity matrix.   

Notice that the parcel selected in the matrix is outlined in white on the surface, but no ID spheres 
appear because an entire parcel was selected from the matrix (rather than a particular brainordinate 
within a parcel). 

• In the Montage viewing tab (the currently active tab), click on the Settings         button next to 
the top layer’s On checkbox.  

• Click on the Parcels tab in the Overlay and Map Settings box that popped up.  Here one may set 
the Color Mode of the selected parcel for a *.pconn file. Outline or Fill indicates the selected 
parcel by the Color selected below. The Off setting turns off the displayed indication of which 
parcel is selected.  

• Close the Overlay and Map Settings box. 

• Click on the Chart viewing tab at the top of the Workbench Window.  

• In the Overlay Toolbox, the Charting and Connectivity tabs are active. In the Charting tab, The 
Settings         button opens the Palette Color Mapping Editor that controls the palette and 
thresholding for the displayed matrix file. The Colorbar button controls display of the matrix 
palette spectrum.   

• Click on the Connectivity tab. The On checkbox in the Connectivity tab control whether data is 
loaded for the listed parcellated connectivity file as brainordinates are identified.  

• Toggle the On checkbox off.  

• Click the surface. Notice the connectivity map now does not change when you identify 
brainordinates.  

• Click on a row in the parcellation connectivity matrix. Notice that the map does change 
because, rather than brainordinates, you are selecting parcels from the matrix for connectivity 
display. 

  

http://www.humanconnectome.org/
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Figure 19 – Surface montage, showing group-average 
myelin map and parcellation borders.  

 

Scene 9: Parcellation Borders displayed with parcellation 
labels on R440 surfaces 

• Select Scene “Parcellation Borders displayed with parcellation labels on R440 surfaces” in the 
Scenes Window and click Show to load the scene. 

This scene displays surface borders (contours demarcating boundaries between regions) and shows 
features of the Workbench Features Toolbox. The Features Toolbox currently enables you to display 
loaded borders, foci, and labels. With the changes to the border file format described in the 
Introduction, we also show you the steps needed to convert older border files into the new format in 
the wb_view GUI. 

The scene opens with a montage of R440 inflated cortex surfaces showing colored cortical areas 
depicting an architectonic and retinotopic parcellation map published by Van Essen, Glasser, Dierker et 
al. (2011b) (VGD11b) over the R440 sulc map.  

The Features Toolbox is displayed on the right side of the Workbench Window and borders outlining the 
VGD11b parcels are set to display.  

• Notice the borders that are being displayed match the parcellation map that is displayed as the 
top layer in the Overlay Toolbox. 

• Toggle the Display Borders checkbox off in the Features Toolbox. This will turn off all the 
borders at once. 

• Toggle off the first layer and toggle 
on the second layer, the R440 
group-average myelin map. 

• Rotate the surfaces (press the left 
mouse button and drag your 
mouse).  

• Toggle the Display Borders 
checkbox on and off in the Features 
Toolbox. Notice how many of these 
outlines roughly line up with 
changes in myelin content (changes 
in the map color, recall myelin 
content is heaviest in the areas 
displayed in warmer colors) that 
suggest borders between cortical 
areas (Figure 19). Leave the Borders 
on.  

As you can see, the borders are useful to mark just the edges of cortical areas when you are viewing 
various types of data on the cortical surface. 

http://www.humanconnectome.org/
http://cercor.oxfordjournals.org/content/early/2011/11/02/cercor.bhr291.long
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Notice in the Features Toolbox that we are currently in the Borders tab. We’ll discuss the Labels tab 
later in this scene and the Foci tab in the next section. The Fiber tab is currently under development for 
use with diffusion MRI data and is greyed out unless WB-compatible fiber or trajectory files are loaded 
(not yet released).  

In Borders, under the top level of tabs, there are two tabs for Attributes and Selection. We are currently 
in the Selection tab, which allows you to choose which of the loaded borders you want to display.  

Borders are listed in a file tree grouped by hemisphere and border class. In this case, borders are classed 
by an abbreviation (e.g. BSW08) for the article in which the borders were defined. 

• Note that the border KPO10 is currently toggled off in both the left hemisphere and right 
hemisphere lists. This was done to highlight area MT in the lateral side of the occipital lobe. 

• Click the checkbox next to border KPO10 in the left hemisphere list. Toggle it on and off. Try this 
again with KPO10 in the right hemisphere or some of the other sets of borders in the list.   

• Click on the grey triangle       next to border KPO10. This reveals the borders that make up this 
border class and allows you to turn them off and on one by one.  Try toggling a few of these 
borders off and on. 

• Above this border list there are two buttons for turning All the listed borders Off or On. Click 
these buttons and note that all the borders listed show checkboxes that match the Off or On 
status.  

• Now click the Attributes tab above. The Borders:Attributes tab contains controls for adjusting 
the coloring, size, and symbol type for the borders displayed.  

• Toggle the contralateral checkbox. This displays the corresponding borders from the 
contralateral hemisphere so that you can compare the differences between the cortical areas 
between hemispheres. 

• Click the contralateral checkbox again to turn it off. 

• Click off the Display borders checkbox.  

• Toggle the top parcellations… layer on again in the Overlay Toolbox. 

In Workbench, label files assign each surface vertex a specific ‘categorical’ name and an associated color 
(or paint). When labels are displayed, regions appear painted on the brain surface. The parcellation map 
in the top layer is made up of many of these labels that describe and color cortical areas.  

• Click the Labels tab at the top right of the Features Toolbox and click on the Selection tab.  

Here you see that the Labels:Selection tab has the same structure as we saw for Borders. 

• Click on the grey triangle       next to Composite Parcellation-lh. As we saw for borders, this 
reveals the labels that make up this label group and allows you to turn them off and on one by 
one.   

http://www.humanconnectome.org/
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• At the bottom of this long list is the red label hOc5_MT for area MT in the occipital lobe. Try 
toggling this label off and on and notice how this label roughly lines up with an orange/yellow 
patch on the myelin map of the R440 subjects, indicating high myelin content. 

• Scroll up to the top of the Features Toolbox. Click the Attributes tab.  

• Move your mouse over the Draw as: dropdown and click and select Outline Color or Outline 
Label Color. Look at area MT again and see how you can now directly compare the outline of the 
label for MT and the myelin map in much the same way you did when we were looking at 
borders. 

Converting old Border files to the new Format 

Previously, border files could contain borders drawn on single or multiple brain surface structures. New 
to Workbench 1.0 is an improved border file format that requires borders in one file to be associated 
with a single structure. Old border files can still be read by wb_view and wb_command as long as the 
structures on which they were drawn are also loaded in the same session.  

We recommend that users with border files created in previous versions of Workbench update their 
border files to the new format so that they may be edited in wb_view.  

The border files that are provided in this dataset are in the old format drawn on single left and right 
hemisphere structures, respectively, so that we may demonstrate the conversion.   

When the parcellations_VGD11b.L.32k_fs_LR.border and parcellations_VGD11b.R.32k_fs_LR.border files 
were loaded in this scene with their respective surface structures, wb_view automatically converted 
them to the new format for display/editing, but they need to be saved to make the changes permanent.  

• To save the border files in the new format, click on File Save/Manage Files…  
• Notice that the Border files listed have YES in the Modified column indicating that they have 

been changed since they were loaded.  

When files are modified in a wb_view session, the Save checkbox is automatically checked to make it 
easy to save your changes. If you do not want to save your changes to particular files, you may uncheck 
these boxes before saving.  

• Leave the Save checkboxes checked beside the Border files listed. 
• Click the Save Checked Files button to complete the writing of the new border files (overwritten 

with the same name as the old format files). 
• When this scene is reopened, the new format files will be read and the files will no longer be 

labeled as Modified in Save/Manage Files. 

If you have old border files on multiple brain structures that you want to convert, you must use the Split 
Multi-Structure Border Files option in the Data Menu to separate the borders by structure before 
editing or saving borders in the new format (border editing and saving is blocked for multi-structure 
border files). Scenes created with old border files will also open, but if borders are edited or if the file 
name is changed, the scene will need to be replaced (or a new scene created) to reflect the changes, 
including updating the border file format.  

http://www.humanconnectome.org/
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For information on using tools in wb_view to draw or edit existing borders, see the Help sections under 
ToolbarModeBorder Drawing.   
  

http://www.humanconnectome.org/
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Figure 20 – Left midthickness group-average surface 
showing ESM05 foci. Focus AIPS_IP3 is deselected and 
therefore not displayed.  

 

Scene 10: Foci displayed on R440 surfaces 
• Double click on “Foci displayed on R440 surfaces” in the Scenes Window, to load the scene. 

This scene displays identified foci (identified spatial coordinates of interest) that were generated by 
Glasser and Van Essen (2011) using the centers of gravity of the volumetrically analyzed probabilistic 
cytoarchitectonic areas delineated by the Zilles/Amunts group.  Hence, the foci are given "Class Name" = 
ESM05 to reflect the Eickhoff et al. (2005) citation. These areas were used as an important comparison 
to the myelin maps in the Glasser and Van Essen paper. 

The scene opens with the inflated group-average left hemisphere surface showing the identified foci. As 
with Borders and Labels, the Foci tab of the Features Toolbox has Attributes and Selection subtabs. 
Here, we begin in the Attributes tab. 

• Click on the Attributes subtab in the Features Toolbox. 

• Toggle the Display Foci checkbox to globally turn foci off and on.  

• Toggle the Contralateral checkbox to 
display foci from the right 
hemisphere in their corresponding 
locations on the left hemisphere to 
compare foci positions between 
hemispheres. Toggle it back off. 

• Toggle the Paste to Surface 
checkbox.  

This option moves displayed foci to 
the nearest location on the surface 
being displayed. This is useful 
because identified foci are often 
slightly above or below the surface 
because of differences in anatomy 
between subjects, this option brings 
the foci back to the surface you are 
displaying them on so that you can 
see all of them clearly.  

• Click on Tab 2 at the top of the Workbench Window, showing the left group average 
midthickness surface (Figure 20).  

• Toggle the Paste to Surface checkbox off and on again. This feature is especially useful when 
looking at foci in the sulci of anatomical surfaces. 

• Click on the Coloring dropdown. You can set colors of foci based on individual name (the 
default) or by class (here all the foci have the same class, ESM05, which is set to black).   

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/32/11597.long
http://www.sciencedirect.com/science/article/pii/S105381190400792X
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In order to edit individual foci name colors or class colors in Workbench, you must use the Edit Foci 
function described in Help ToolbarModeFoci CreationFoci Editing.   

• Move your mouse over and scroll through or select the options in the Draw As and Symbol Size 
dropdowns.  

• Click on the Foci:Selection tab, which allows you to choose which of the loaded foci you want to 
display.  

• Try toggling a few of these foci off and on. 

• Above this focus list there are two buttons for turning All the listed foci Off or On. Click these 
buttons and note that all the foci listed show checkboxes that match the Off or On status.  

• Click on Tab 1 at the top of the Workbench Window. 

This Montage view is displaying the Zilles/Amunts derived foci on both hemispheres. 

• Click the On checkbox for the top layer to show the combined architectonic and retinotopic 
parcellation labels that we explored in previous scenes.  A subset of the identified foci 
represent the center of gravity of the parcels shown. 

The Group setting at the top of the Features Toolbox for Borders, Foci, or Labels allows you to set a 
display group for each Viewing Tab so that unique features settings (e.g. borders display on, foci 
displayed as squares, etc.) can be applied specifically to particular groups of Workbench Window display 
tabs and not others. 

For information on using tools in wb_view to create or edit existing foci, see the Help sections under 
ToolbarModeFoci Creation.   

 

  

http://www.humanconnectome.org/
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Exploring HCP data at 164k Vertex Resolution  
The following scenes explore the data provided on a higher resolution surface mesh. The higher 
resolution is useful for deciphering fine details of anatomical features such as curvature, cortical 
thickness and myelin maps. The scenes are setup very similarly to the first three scenes we explored on 
the 32k mesh to make it easy to compare the 164k data provided in the dataset.  
 
Note: Since many of the files in these scenes are higher resolution, and several times larger than the 32k 
files, it will take a bit longer to load these scenes.  

Scenes 1 and 2: Individual surfaces and volumes (164k) and 
Individual vs. Group Avg surfaces and volumes (164k) 

• In the Scenes Window, change the Scene File dropdown to WB_1.0_SCENES.164k_fs_LR.scene.  
• Double click on the scene names to load them. Roughly follow the instructions for Scenes 1 or 2 

at 32k or explore the data loaded on your own. 

Scene 3: Individual vs Group Avg Myelin Maps on R440 
Surfaces (164k) 
Scene 3 at 164k is setup similarly to Scene 3 at 32k, but we want to show another set of data files here 
that display maps from all R440 subjects. Because these files contain many maps at 164k, this scene 
takes a particularly longer time to load. 

• Double click on “Individual vs Group Avg Myelin Maps on R440 Surfaces (164k)” to load the 
scene.  

The scene opens with the myelin map for subject 100307 displayed on inflated R440 surfaces.  

• Click on the File pull down for the top layer. Select the                                                                              
Q1-Q6_R440.All.MyelinMap_BC.164k_fs_LR.dscalar.nii file. Note that the myelin map displayed 
did not change. 

• Click on the Map selection pulldown for the top layer. A long list of maps by subject number will 
appear with a checkbox next to the first subject listed, 100307 (Figure 21). 

This file contains individual myelin maps for each of the R440 group that can be explored to see the 
individual differences in myelin content between subjects.  

• Select subject 101915 near the top of the list. Notice that this subject displays high myelination 
in a well-defined, nearly circular area around MT+ in both hemispheres (Figure 22, left).  

http://www.humanconnectome.org/
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Figure 21 – Q1-Q6_R440.All.MyelinMap Map List.  

 

 
Figure 22 – Comparing individual Myelin maps for R440 subjects.  

 

• Click the Map selection pulldown 
again and select subject 111413, 
near the middle of the list. Notice 
that this subject displays much less 
and diffuse myelination around 
MT+ in both hemispheres (Figure 
22, center).  

• Again, click the Map selection 
pulldown and select subject 
131924, further down in the middle 
of the list. Notice that this subject 
displays diffuse myelination around 
MT+ in the left hemisphere, but 
high myelination in a well-defined 
area around MT+ in the right 
hemisphere (Figure 22, right). 

• Click in the Map number box to the 
left of the Map selection pulldown 
to activate the box (should be 
outlined in a blue glow).  

• Use the mouse scroll wheel or arrow keys to toggle quickly through the myelin maps.  

• Click on the File pulldown for the top layer and note the “All” files for corrected thickness, 
curvature, sulc, and thickness.  

• Explore these data loaded and compare with the group average maps as you wish.  

 
Thanks for sticking with the wb_view tutorial to the end! Check out the many topics in the Help menu as 
you explore other features of the platform. Remember to join and send bug reports or suggestions to 
the HCP-users list by emailing hcp-users@humanconnectome.org. 
 
Enjoy using Connectome Workbench 1.0 !!  

http://www.humanconnectome.org/
http://humanconnectome.org/contact/#subscribe
mailto:hcp-users@humanconnectome.org
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